Types of CSP conversion services available

There are three types of conversions available for converting your CSP data to Practice CS. Each of these conversion types is discussed in more detail in the following pages.

**Demographic:** The converted data includes only identifying information about clients, staff, offices, and contacts, such as their names, addresses, and phone numbers, as well as practice management system configuration settings such as engagements and activities. The converted data does not include any portions of time and billing elements (time, expenses, invoices, receipts, and adjustments).

**WIP and A/R:** The converted data includes either summary or detail information for unbilled time and expenses, unpaid invoices and unapplied receipts and adjustments.

This conversion includes:

- Identifying information for clients, staff, offices, and contacts
- Detail information for unbilled time and expenses (WIP)
- Information about unpaid invoices
- Detail information for unapplied receipts and adjustments
Historical: The converted data includes detail information for WIP; both unpaid and paid invoices with either detail or summary for billed time and expenses; and both unapplied and applied receipts and adjustments.

This conversion includes:

- Identifying information for clients, staff, offices, and contacts
- Detail information for unbilled time and expenses (WIP)
- Detail information of billed time and expenses for unpaid invoices
- Detail information of billed time and expenses for paid invoices
- Detail information for unapplied receipts and adjustments
- Information for applied receipts and adjustments

Note: The Creative Solutions Practice historical conversion can also include enhanced demographic and detail information for projects and tasks, which are not time and expense elements.

<table>
<thead>
<tr>
<th>Data to be converted</th>
<th>Demographic</th>
<th>WIP &amp; A/R</th>
<th>Historical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demographic Information</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Unbilled Time &amp; Expenses (WIP)</td>
<td>Detail</td>
<td>Detail</td>
<td></td>
</tr>
<tr>
<td>Unpaid Invoices</td>
<td>Detail*</td>
<td></td>
<td>Detail*</td>
</tr>
<tr>
<td>Paid Invoices</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billed Time &amp; Expenses</td>
<td>Detail</td>
<td>Detail</td>
<td></td>
</tr>
<tr>
<td>Unapplied Receipts &amp; Adjustments</td>
<td>Detail</td>
<td></td>
<td>Detail</td>
</tr>
<tr>
<td>Applied Receipts &amp; Adjustments</td>
<td>Detail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projects and Tasks</td>
<td>Detail</td>
<td>Detail</td>
<td>Detail</td>
</tr>
</tbody>
</table>

* Negative invoices are converted as debit adjustments with no information about billed time & expenses

With each type of conversion, you also have the option to convert all completed and uncompleted ticklers, staff budgets, and staff benefits — including accruable benefit work codes and opening balances, plus comp time opening balances.

Note: Projects are called ticklers in Creative Solutions Practice.
Notes

- Though we offer historical data conversion, we encourage you to make a fresh start in Practice CS by choosing either the demographic information conversion or the WIP and A/R conversion. With converted historical data, you may experience issues with performance and database size, and in some cases the historical data can be confusing.

- For an overview of the historical data conversion process, please see “Overview of the process for having us convert your data” below. For information and pricing, please call (800) 968-8900 and ask to speak to your Sales representative.

Overview of the process for having us convert your data

If you plan to use the export/import utility to convert setup information and/or open balances yourself, please skip to “What to expect from all three types of CSP data conversions” below. If you want us to convert your data from CSP, you will need to contact your CS Sales representative.

- After you make arrangements with your CS Sales representative, a Conversions specialist will contact you to schedule your appointment. The Conversions specialist will then send you an appointment confirmation form via email. This form confirms the information you gave to us and informs you of your conversion appointment date (when we will expect to receive your data). The Appointment Confirmation form also includes instructions on preparing and shipping your data to us. When we schedule your appointment, we will also tell you the expected turnaround time for converting your data. A normal turnaround time is one week from your appointment date. This means if we receive your data on or before your appointment date, we will ship converted data back to you within one week of your actual appointment date. Some exceptions may apply.

- Once we receive your CSP data, we will convert it here at our facilities in Michigan. We will prepare your converted data in the Practice CS format and return it to you.

- After the conversion is complete, we will return your converted data for Practice CS. We will include any additional information you need to know about your conversion, and we will recommend the best way to install your data.

What to expect from all three types of CSP data conversions

The overall objective of the Practice CS data conversion is to produce accurate firm data for the Practice CS program. This data enables you to produce standard reports with all the relevant information. Due to variations in the software structure, and because there is information in your current CSP database that is not used in Practice CS, some information will not be converted. Therefore, you should not expect to exactly duplicate results from CSP using the converted data without adding or modifying the appropriate data in Practice CS. We've listed the specific items to be converted on the following pages.

# Items that will be converted

The following table is a summary of the data items that the Practice CS Conversion Service will transfer from CSP for each type of conversion.

<table>
<thead>
<tr>
<th>Setup information</th>
<th>Demographic</th>
<th>WIP and A/R</th>
<th>Historical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Code IDs and descriptions</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Engagement type IDs and descriptions</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Firm information such as period dates, names, address, service charge information, dunning messages</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>All staff along with the following assignments: ID, First, Middle and Last Name, SSN, Exam passed, Experience met, Education met, Hired date, Left date, Office, Department, Supervisor, Level, Billing rates, Cost rate, title, Address, phone numbers, Memo, Expertise Areas/Rankings, Birth date, Spouse, and Emergency contact</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>All Work Codes along with the following assignments: ID, Description, Long description, Type, GL Account, Work code group, rate information, rounding, Taxable information, and surcharge information</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Staff budgets</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Staff benefits: accruable benefits work codes and opening balances</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Staff benefits: comp time opening balances</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Demographic</td>
<td>WIP and A/R</td>
<td>Historical</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>All clients along with the following assignments: ID, Alpha, Name1, Name2, EIN/SSN, Taxpayer name, Spouse, FYE, Office, Entity, Owner, Manager, Staff, start date, left date, all contacts, Contact Name, Address, Phone numbers, Salutation, Title, Email, Selection Codes, Engagements with descriptions, Office, Biller, Manager, rates and Fixed Fee Billing Information, Assess Service Charge information, SIC, Billing Instructions (Notes), Memo, Custom Fields, Investment limit, Sales volumes, Ratings, and Sizes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>All Event Profiles including ID, Description, Priority, In Charge, Preparer, Occurrence, dates, extensions, and tasks</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Uncompleted ticklers and associated tasks</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td><strong>Transactions</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All open WIP (if you perform the Setup information + Open WIP and A/R balances conversion yourself). All billed and unbilled WIP entries (if we perform the Historical Data conversion for you).</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Nonbillable time</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>All open invoices (if you perform the Setup information + Open WIP and A/R balances conversion yourself). All paid and unpaid invoice entries (if we perform the Historical Data conversion for you). <strong>Note:</strong> Negative invoices will not be converted. A zero-dollar invoice along with an adjustment credit memo for the amount will be created. This will help maintain the A/R balances.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Demographic | WIP and A/R | Historical
--- | --- | ---
All open receipts, service charges, debits and credits (if you perform the Setup information + Open WIP and A/R balances conversion yourself). All allocated and unallocated receipts, service charges, debits and credits entries (if we perform the Historical Data conversion for you). | No | Yes | Yes
All uncompleted ticklers and tasks (if you perform the Setup information + Open WIP and A/R balances conversion yourself). All completed and uncompleted ticklers (if we perform the Historical Data conversion for you). | Optional | Optional | Optional

Items that are not converted

The following items are not converted due to differences in data structures between CSP and Practice CS. After your conversion, enter the applicable items before you begin using Practice CS.

**Invoice and Statement Formats** — No formats will be converted due to the significant differences between programs. You can modify or copy the default formats or add new ones from Setup > Custom Formats.

**Security Levels** — In Practice CS, you can choose whether or not to enable firm security. If you have chosen to enable this feature in the Firm Setup screen, you will need to create security groups from Setup > Security Groups and then assign them to your staff members.

**Invoice Images** — Invoice Images will not be available in Practice CS. You may choose to keep these files, which are stored in the \Wincsi\PS\Invoice folder as individual invoice snap images. You can view these images from the Microsoft SnapShot Viewer by double-clicking them.

**Creative Solutions Practice Module Data** — Information pertaining to other modules of CSP will not be converted. These include data from the PS/Market® module (activities and referrals); data from the PS/CPE Management® module (boards, courses and staff requirements); and the Smart Scheduler and Work Calendar from the Scheduling Solution® module.

Steps required prior to CSP data conversion

Whether you plan to use the export/import utility to convert CSP data yourself or plan to send your CSP database to the Conversions team for us to convert, you must first complete the following steps in CSP to ensure that the conversion process runs in a quick and efficient manner.

1. Stop any active timers.
2. Post any timesheet batches.
3. Post or cancel all invoices on review.
4. Roll over all completed and recurring ticklers that have not already been rolled over.

5. Set the current period to the period for which benefits and comp time opening balances will be created.

6. Due to changes to all ID fields, you may want to rename any that contain characters other than alpha or numeric characters. Any ID field with spaces or characters such as "&", "-", or even a period (.) will be stripped of these characters. If such characters are stripped during the conversion, this information will appear in the Exception Report. This report appears when you use the Export/Import feature to convert data or is sent to you with your data if we convert your data for you.

7. Due to changes in the lengths of all description fields, you may want to reword or truncate any descriptions that are longer than 30 characters. The conversion program automatically truncates such descriptions to 30 characters. If any descriptions are truncated during the conversion, this information will appear in the Exception Report.

8. Repair and compact your database. If you cannot compact your database, call CS Product Support at (800) 968-0600 to resolve the issue prior to your conversion date.

---

**Important!** Make a backup of your database. The conversion may make changes to your data, if needed.

9. Print your period reports so that you can use them to verify your data after the conversion.

10. If you haven’t already installed Practice CS, install it prior to converting. For more information on installing Practice CS, refer to the *Practice CS Getting Started* guide.

---

**Note:** To help facilitate the conversion process, we strongly recommend knowing how to use the Practice CS program prior to converting your data. Once the conversion is complete, you should be prepared to start using Practice CS.

Please visit our website at CS.ThomsonReuters.com for the latest training information and schedules. A CS Account Representative can help you choose the training that is right for you.

---

**Instructions for using the export/import utility to convert WIP and A/R data from CSP**

Practice CS has an export/import utility that enables you to convert your CSP setup and open balance data in your office at your convenience. Please follow the steps below to run either the Demographic conversion or WIP and A/R conversion.

**Notes**

- If we are converting your CSP data, do not complete these procedures. We will convert the setup and open balance data along with your historical data.
- The export portion must be done from a computer with either CSP installed or Microsoft® Access® 2000 or higher installed.
Exporting data from CSP

1. In Windows® Explorer, navigate to the \Wincsi\Practice CS\Conversion folder.

   Note: If you are running Practice CS in the Virtual Office CS® environment, you will need to navigate to the conversion folder via Practice CS.

   - In Practice CS, click the Staff button in the navigation pane, and then click the Dashboard action icon (or choose Staff Dashboard from the View menu).
   - In the Staff Dashboard, click the Select Portlets link.
   - In the Add Portlet dialog, mark the Solutions checkbox and then click OK to open the Solutions portlet.
   - Within the Solutions portlet, right-click and choose Add Solution from the context menu.
   - In the Select Solution to Add dialog, navigate to Y:\Practice CS Data, select CSPExport.mde, and click Open to add it to the Solutions portlet.

2. In the Wincsi\Practice CS\Conversion folder, double-click the CSPExport.mde file. This MDE file is an export utility that will pull data from your current CSP data structure. Later in the conversion process, you will need to import this information into Practice CS.

   Note: Virtual Office CS users: Click the CSPExport.mde file in the Solutions portlet to run the export utility.

3. Select the information you would like to export from CSP. Your options are Setup information only (Demographic) or Setup information + open WIP and A/R (WIP and A/R). After you select the appropriate option, click the Next button.
4. Enter the path to your CSP database. The default path is to your current CSP data location. Then enter the path to a destination folder for your exported data or use the default location (\WinCSI\PSData\Exported_Data). Click the Next button.

**Note:** Virtual Office CS users: The path to the destination folder for your exported data is Y:\PSData\Exported_Data.

5. Select the Practice CS phone descriptions that should be used in place of your CSP phone descriptions. The export utility will populate the Practice CS description with the closest match from CSP. If the utility cannot find a match, it will leave the field blank. For each unmatched phone description, you can let the export utility find an available spot, or you can select an item from the list. Click the Next button.
6. Select project and staff export options. On this page of the dialog, you can do the following:

- Mark the *Export Ticklers and Tasks* checkbox if you want to export this information to the Practice CS Project Management module.
- Mark the *Export Standard rate* checkbox to export staff standard rates and add a description to be used in Practice CS. When exporting the staff standard rate, you also have the option to mark the *Export Staff Budgets* checkbox to export that information to the Practice CS Staff Management module.

Click the Next button.

7. Select firm and benefit export options. On this page of the dialog, you can do the following:

- If you want to use an existing CSP client to create an administrative-class firm client in Practice CS, mark the *Create Administrative-class Firm Client* checkbox, then select the CSP client and choose an ID and name for the client in Practice CS.
- Mark the *Export Benefit balances at the start of the Current Period* checkbox if you want to export that information to the Staff Management module. You can also mark checkboxes to convert accruable benefits and comp time.
- Mark the *Create Administrative-class Activities for other Non-billable Work Codes* checkbox to create new administrative-class activities in Practice CS from existing non-billable CSP work codes.

**Notes**

- When benefits are exported, the work codes for accruable benefits are converted to administrative-class activities with a BEN prefix.
- Administrative-class activities for all other non-billable CSP work codes will be created with an ADM prefix.
Click the Next button.

8. Click the Export button to begin the export process. When the export has finished, you will be able to view and print an Exception Report, WIP Balance Report, and/or an A/R Balance Report.
The Exception Report lists any special characters stripped from ID fields, any fields that were truncated, any phone number mapped to a different location, timesheet items that could not be converted, and any other criteria that violate the rules of Practice CS.

The WIP Balance Report (Setup information + open WIP and A/R balances conversions only) displays any WIP differences during the export. This is merely an exception report if the balance from CSP differs from Practice CS.

The AR Balance Report (Setup information + open WIP and A/R balances conversions only) displays any A/R differences between the A/R that was actually exported and the A/R balance in CSP. The report lists the difference by client ID and gives a brief explanation of the difference. One potential cause for the A/R to be different is if a payment exceeds an invoice amount. This is not allowed in Practice CS, so the credit balance cannot be converted.

9. After previewing and printing the reports, click the Exit button to close the export utility.

Importing CSP data into Practice CS

Note: If you receive any errors during the import procedure, please contact CS Support with the information contained in the error dialog. To speak with a Product Support Representative for help on these errors, please call CS Support at 800-968-0600, press 2 for Product Support, and then listen to the available options. Normal weekday support is available from 9:00 a.m. to 8:00 p.m. eastern time.

1. Start Practice CS.

2. If you have not already done so, create a new firm.

   Notes
   - You must open a firm database, such as the Sample database, before creating a new firm.
   - Your new firm name cannot contain spaces or non-alphanumeric characters.

3. After creating the new firm, open the firm (File > Open Firm).

4. From the File menu, choose Import > Conversion Data.
5. In the Import Conversion Data dialog, enter or navigate to the location of the data you would like to import. The default path is \WinCSI\PSData\Exported_Data. This is your destination location from step 3 in the previous procedure.

   **Note:** Virtual Office CS users: Enter Y:\PSData\Exported_Data\ for the path to your conversion data.

6. Click OK to import the data. When the import is complete you will receive a message indicating that the import was completed successfully.

7. Verify that Practice CS is in the correct period. The current period appears in the lower right corner of the application window. If the period is not correct, you can change it by choosing Actions > Change Periods.

8. Verify your data by comparing Practice CS reports to the period reports that you printed before the conversion (step 8 under “Steps required prior to CSP data conversion”).

9. Click OK. Practice CS is now ready to use.